
Overview - PhotoWatermark Professional
PhotoWatermark Professional - the way to create professional 
watermarks

PhotoWatermark Professional is the only digital photo-watermarking tool that combines power and ease of use, and
radically simplifies the process of creating and applying watermarks to multiple files. It uses a mixture of text, 
graphic and drawing objects of varied complexities. Highlights of this program include: 1) Choose between styles of
outline and angled text, gradient or texture fill, embossing or engraving, soft shadow, Shadow3D and photo 
framing, which render you watermarks that speak of professionalism.    2) Automatic objects can extract various 
EXIF and file data from images. 3) Automatically sizes watermarks to the width of image. 4) Transparency settings 
allow you to choose how your image samples will be presented to your potential customers. 5) Works with common
image formats such as JPEG, TIFF (inc. multi-image TIFF), BMP, GIF (inc. animated gif), PNG, and JPEG2000. 6) A 
built-in watermark manager helps you manage multiple watermark files and switch easily. 7) Contains 60 sorting 
variables. 8) Supports combinations of batch watermarking, converting, resizing, renaming, cropping, rotating, 
image enhancing, printing and framing. You can expect all these wonderful features, and much more! You are 
guaranteed to create your first watermark in just 90 seconds!

 

Copyright (c) 2002-2004 PhotoWatermark.Com. All rights reserved.



What's new
Oct 16, 2004 V5.6.0.0
· New: The long-awaiting BIG feature is now ready. Automatically size watermarks by percentage of the image 

width.
· New: Enlarge canvas to fit watermark option under "Image menu".
· New: Specify number of copies in the print dialog.
· New: Turn off error message option.
· New: Use zoom filter option.

Oct 04, 2004 V5.5.3.3
· Bug fix: Emboss and engrave frame objects can be drawn properly now.

Sep 28, 2004 V5.5.3.2
· Bug: Now it can process images larger than 35 Mega Pixels.

Sep 20, 2004 V5.5.3.1
· New: When you turn option "Allow me to overwrite source image files" on and the browse for folder window will 

display a button which lets you go to source folder directly.
· Bug: Rename now works again during batch processing.
· Bug: Grayscale and Sepia in the output window are not mutually exclusive.

Sep 18, 2004 V5.5.2.0
· New: image size can specify percentage now. 100% means original. You can still specify image size in 

WidthxHeight format.

Sep 11, 2004 V5.5.1.0
· New: 60 sorting variables including sorting by number of pixels, picture taken date and picture taken time.
· New: Rename template supports custom increment (used to be one only).

Sep 06, 2004 V5.5.0.0
· New: True emboss of any objects
· New: True engrave of any objects
· New: Any object can be 3D.
· New: Support custom photo frames of PNG files with alpha transparency.
· New: Auto number object, which marks the number of the photo in the current list.
· New: Sort by file name or by Date picture taken.
· New: Can produce sepia image.
· New: Output can be grayscale, sepia or color.
· New: Customizable output file extension case.
· Changed "Adjust" menu to "Enhance".
· Optimized image enhance commands and sequence.
· Improved image effect commands.
· Other improvements.
· Bug: Now Tip bar does not come back after you turn it off.

Aug 28, 2004 V5.0.6.6
· Added a flash tutorial - 96 seconds to create copyright watermark.
· Added Objects tab, which will list all objects allowing you to view objects' attributes and select them.
· Changed some default values.

Aug 20, 2004 V5.0.5.5
· Bug fix: Now reads Chinese file names properly. This bug was introduced in V4.

Aug 16, 2004 V5.0.5.4
· Bug fix: Print commands now work consistently.

Aug 06, 2004 V5.0.5.3
· Bug fix: Batch converting to TIFF now works.
· Interface improvements.

Aug 04, 2004 V5.0.5.2
· New option (Convert and rename options): Keep EXIF. If unchecked, EXIF will not be saved.
· New option    (Convert and rename options): Case - As is, upper or lower.
· JPEG color space now defaults to YCbCr, which will create a smaller file.



· Two more JPEG output controls: optimizing and DCT (Discrete Cosine) methods.
· Options available with Save As dialog.

July 29, 2004 V5.0.4.2
· Now exposes more options for file format controls, e.g. JPEG color space, TIFF color space, TIFF compression, 

PNG background color and so on. All these options are available in the Convert and rename options window.
· Now show error messages for unhandled exceptions.

July 22, 2004 V5.0.3.2
· New image adjustment: Shape and feather. You can create a rounded, rectangular or an elliptic image with or 

without feathering edge. Unfortunately, this feature does not work properly under Win9x.
· Interface improvements.
· Changed dynamic image adjust menu to "Adjust".

July 11, 2004 V5.0.2.2
· New: Search photo by date picture taken, size of mega pixels, and any other EXIF data.
· Bug: Can deal with photos with invalid dates (e.g. '0000:00:00 00:00:00').

July 01, 2004 V5.0.1.1
· New: "Limit file size to" option is added to the "Convert and rename" option window. This only applies to JPEG 

format. If you want quality, do not do this.
· Bug: Merged animated gif frames are not shifted anymore.

June 25, 2004 V 5.0.0.0
Powerful new features include:
· Gradient and bitmap pattern fills of text and shape objects. 
· Multiple line text objects can now have angled fonts.
· Smooth rendering of individual object.

June 10, 2004 V 4.4.1.3
· Added: a 4-step watermark wizard.
· Replaced <Edit - Text box tolerance> with <Edit - Text auto size>. If a text box is set to `not auto size', you will 

be able to manually size it.
· Now loads merged animated GIF files properly.
· Bug fix: The default transparency value was set to 100%, which made the new object invisible. Now it is set to 

0.

May 30, 2004 V 4.4.0.2
· Added "Text box tolerance" spin edit box. This is a temporary solution to ensure non-clipped text box but still 

keep your box as small as you desire. You need to play around with this because proper text box during working 
may still get clipped in the output. The suggestion is to save a picture and see what it looks like.

· Added "Gray scale" image effect.

May 29, 2004 V 4.4.0.1
· Bug fix: frame object did not work properly.

May 28, 2004 V 4.4.0.0
· All functions are available on both Win9x and NT based systems. 
· Removed "Use individual object transparency" option since it is useless.
· Added shadow adjustment commands: radius, x and y offset.
· Added image processing commands for inserted image: rotate (any angle), flip horizontally or vertically.
· Removed font shadow, font emboss and font engrave styles. You can obtain these results with the shadow 

settings.
· Some icons are replaced with new ones.
· Increased the text box size so that text will not be clipped in some situations.

May 18, 2004 V4.3.1.9
· Bug fix: Super smooth fonts only available during preview.
· Bug fix: Rotation did not work.
· Bug fix: Keep long side now works properly.

May 16, 2004 V4.3.1.8
· More detailed hints for most commands and combo boxes. Move your mouse over the command or combo box to

show the hint. For example, if you move your mouse over the combo box on the image toolbar next to 
<Image>, it will display a hint window saying "Choose or type in your image size in widthxheight format (eg 
123x88) and press enter."

· New <Very basic tool> above the working image. These commands are the very basic ones you will need to 



create and batch watermark your pictures.
· A step-by-step tutorial of the very basic features, which can be accessed with <Help - Tutorial>.
· Added <Help - FAQ>. Access the FAQ section of the help file directly from within the program.
· Added <Help - What is new>: Access what's new in the help manual.
· New sorting algorithm now sorts files according to numbers in the file if applicable under WinXP, e.g. for 1.jpg, 

2.jpg and 10.jpg
Previous sorting would be

1.jpg
10.jpg
2.jpg

Now
1.jpg
2.jpg
10.jpg

· Added "Restore extension" option in the Rename window. If checked, appropriate file extensions will be 
recovered according to their formats, i.e. .jpg for JPEG, .tif for TIFF, .gif for GIF, .bmp for Bitmap, .png for PNG 
and .jp2 for JPEG2000.

· Added option: Allow me to overwrite source image files (IRREVERSIBLE! you are 100% responsible). When you 
turn this option on, you will be able to overwrite your source image files.

· Font border color available when "Use individual object transparency" is on.
· Antialias rendering of object when "Use individual object transparency". Not available under Win9x systems.
· Super smooth fonts if Antialias is on.
· FTP features: download files and folders, upload files and folders, delete, rename, create new folder.
· Batch cropping after manual definition of crop windows. You can define a crop window for each picture to be 

watermarked and batch process them using combinations of watermarks, resizing, renaming and converting. 
Optionally, these crop windows can be saved so that they can be used in the future.

· Added an option "Save and use crop windows". This option must be on for crop windows to be saved and reused.
· The crop tab, collage tab and FTP tab have their own toolbars and commands are also available in the main 

menu when the tab is selected.
· Rewritten tips only showing the very basic features.
· Improved collage feature: white margin and repeat picture. Manual dragging is not yet supported.
· Bug fix: now you can only rename original files using the Batch Rename command.
· Bug fix: when opening files for processing, after renaming is complete, you will be able to keep your file list.

April 28, 2004 V4.2.1.7
· Bug fix: Now you can change the font to a custom size by typing in a number.
· Changed the way of creating text and image objects. No drag is needed anymore.

April 17, 2004 V4.2.1.6
· Now memorizes the last output folder.
· Now tip will scroll when text is more than two lines.

April 12, 2004 V4.2.1.5
· Added: Rename extension. Caution: at your own risk
· Now load images with wrong extensions, e.g. JPEG image with .GIF extension.
· Display actual image type on thumbnails.
· Bug fix: Only saved the first line of multiline text objects.

April 10, 2004 V4.2.1.4
· Minor improvements. No new features.

April 02, 2004 V4.2.1.3
· Added: collage images of 2, 4 or 8
· Added: save or print collaged images
· Bug fix: when image contains dpi as 0, EXIF will not be loaded properly.
· Renamed "Stretch image" to "Maintain aspect ratio".

Mar 27, 2004 V4.2.0.2
· Added Image effect menu, which includes:

ž Create image from selected objects
ž Add noise
ž Antialias
ž Blur
ž Circle
ž Emboss
ž Mosaic



ž Tile
ž Trace
ž Twist

· Added command: Edit ->-Clear selection.
· Added command: Edit -> Set transparent color.
· Individual X and Y border for each auto position object.
· Added Save attributes menu, which includes:

ž Save as Text
ž Save as CSV
ž Append to CSV
ž Batch save to CSV

· Shows thumbnails in the file list.
· Displays the current file icon beside the "Image file info" object.
· New resizable print dialog.
· Redesigned interface for Convert and rename options.
· Redesigned main interface.
· Changed File info object to "Image file info object" and added more format strings such as one or more w, h, c, 

which represent image width, image height and image color depth.
· Auto position tool moved to the object editor.
· Right button menu for object editor and attribute windows. You can also click the dropdown arrow to bring up 

this menu.
· Added more settings for image size. They are    '1500x1000', '1200x800', '900x600',    '600x400'.
· Added option: Multipage image support.
· Changed "Auto position border" to "Default auto position margin".
· Removed OfficeXP 2003 theme due to its being buggy.
· Renamed "Change DPI to" to "Resolution".
· Bug fix: Auto format (c) and (r) works as you type only when you turn it on and the next character you type is a 

space, tab or punctuation.
· Bug fix: Using the "Rename watermark command" to rename a watermark now works.
· Bug fix: Flickering during batch processing is now fixed.
· Bug fix: When you save current image to a parent folder of the current working folder, several watermark files 

were getting checked strangely.
· Bug fix: When you use move in bound command to move object in and options set to not using individual object 

transparency, the work area was not getting updated immediately.
· Bug fix: Possibility of crash under Win9x.
· Added more Q&A's in the FAQ section.

Mar 01, 2004 V 4.1.2.3
· From now on, version numbers have the following meaning.

· 1st digit, major version. The change of this version will introduce significant new features.
· 2nd and 3rd digits, minor version. The change of this version will introduce new features.
· 4th digit, maintenance version: Any change from the previous version indicates bug fixes.

· Display what's new if program version changes.
· Added View -> Restore all: display all dockable windows as their defaults.
· Added View -> Old interface: Hide all right side dockable windows and make the object editor float.
· Added Options -> Convert and rename options. 
· Added align or distribute commands
· Fixed bug: When you save as a GIF, it does not convert your picture to transparent anymore unless of course, 

the original picture itself is transparent.
· Fixed bug: now your original picture's DPI can be preserved on save if Change to DPI option is not checked.

Feb 28, 2004 V 4.1.1.2
· Moved Watermark menu under File menu in order to prevent confusing about "Watermark" and "Watermark 

object".
· Redesigned watermark manager. Now you always select and check one file. The default name is now called 

"Watermark file (1)" instead of the "Watermark (1)" which also causes confusion between "Watermark" and 
"Watermark object". Also, now you can have no watermark files in the list. However, as soon as you create any 
object, a new watermark file is created.

· Added option: Auto format (c) and (r) marks (English only). This option only works with ANSI system.
· Now when you change the default watermark folder, it does not restart.
· Reordered main menu items.
· Fixed a command line bug.

Feb 25, 2004 V 4.1.1.1
· Display DPI, image size in inch in the property window.
· Added Change DPI to option. This option is available in the Convert rename window. However, it is globally 



available when checked.
· Added import and export watermark file commands under Watermark menu. When you import a watermark file 

in, it will add to the current working watermark file.
· Added option to change the default watermark folder. Click the last menu item under Watermark menu to do 

this. It displays the current default watermark folder.
· Added a new object called Last watermarked. This object will record the date and time the image is 

watermarked. You can apply the same format string as in EXIF date time.
· The bug that creates light border around the image when you check auto brightness and contrast has been fixed.

Feb 21, 2004 V 4.1.0.1
· Bug fix: Memory leak and stop at middle of processing.
· Improvement: Loading JPEG is optimized according to your specified size.

Feb 20, 2004 V4.1.0.0 final
· Added option "Keep long side". If turned on, PWPro will resize your pictures according to the long side.
· Added crop function.
· Added Print current image.
· Added make image current size function.
· Added support for animated GIF and multipage TIFF formats. Now PWPro will watermark every frame and save 

them appropriately. If the format you save does not support multiple pages, each frame will be saved separately.
· Added image adjusting commands: orientation, brightness and contrast, gamma correction, RGB, hue-

saturation-luminosity, hue-saturation-value, grayscale, negative, alpha channel, sharpness and softness. These 
commands are available for all batch processing.

· Changed Resize menu to Image menu.
· Changed batch convert resize to Batch process images.
· Removed default JPEG option. Now uses the JPEG settings in the convert dialog box.
· Now save and load EXIF in TIFF file.
· Added making AVI with or without watermarks.
· In the rename template, illegal file name characters will be replaced by "_".
· Now all dockable panels can remember their heights.
· The main image can load alpha channel now.
· More tips.

Feb 10, 2004 V4.0.0.4
· Fixed a bug when you select multiple text objects, one of the selected turned into empty object.
· Fixed a bug when you click select all, select none, or select invert, selections were not updated.

Feb 09, 2004 V4.0.0.3
· Fixed a bug with same size conversion.

Jan 31, 2004 V4.0.0.2
· Now you can move box, ellipse or polygon by holding the inside of the object when it is not transparent.
· Changed of the flash window.

Jan 27, 2004 V4.0.0.1
· Added option: Hide error objects on watermarked photos. If checked, the error watermark objects will not be 

shown on your final products. This prevents you from removing these objects when you have photos that do not 
contain EXIF or are taken before your specified birthday.

· Now error watermark objects are displayed. They were displayed in the status bar only before.
· Fixed bug: Birthday editor always disabled.

Jan 25, 2004

· Batch print: watermark and print out all your images.
· Searchable help file.
· Dockable object editor.
· More flexible renaming template.

Jan 18, 2004

· Watermark manager: create and manage multiple watermarks.
· Added a Watermarks menu for watermark manager.
· Removed Import and Export watermark.
· Watermark files are stored in users "My Documents\My Watermarks" folder or "Program folder\My Watermarks" 

if "My Documents" folder does not exist.
· Set image transparent: turn on or off image transparency uses color of the bottom left pixel.



· New command line switch "/w xxx", where "xxx" is your watermark file.

Jan 08, 2004

PhotoWatermark Professional 4.0 supersedes PhotoWatermark 3.x. It has the following new features:
· Optional individual transparency level for each object*.
· Customizable target image size.
· 11 resample filters for image resize.
· Batch converting images between JPEG, TIFF, Bitmap, GIF, PNG and JPEG 2000.
· Batch resizing images.
· Batch renaming images using template and create unique file names using EXIF date and time.
· Image frame.
· Polygonal drawing.
· Customizable zoom view.
· Individual soft shadow for each object not limited to text*.
· Extended text styles of outline*, shadow, emboss, and engrave.
· Customizable text border.
· Command line arguments support.
· 22 tips.
· New themes (Office 2003, Office2003 color and Nexos4).

* Available under NT based systems (NT/2k/XP/2003) only.



Features
PhotoWatermark Professional's very basic features include text and image watermark object, automatic position of 
watermark object and batch watermarking. These are the features you will need to start creating and applying your
watermark to your digital photo files in batch.

PhotoWatermark Professional's key features include:
· Green program: Everything is in a single folder.
· Batch: One step to process large number of photos (all files in a folder and also in its subfolders at the same 

time) including combinations of
ž Batch watermarking.
ž Batch renaming: Create unique file names with EXIF date and time.
ž Batch resizing: Can use one of the 11 resample filters.
ž Batch converting: Convert between JPEG, TIFF, Bitmap, GIF, PNG and JPEG 2000.
ž Batch printing: Watermark and print out all your images.
ž Batch rotating: Rotate all your pictures at once.
ž Batch adjusting: Adjust colors of your pictures.
ž Batch cropping: You can define a crop window for each picture and batch crop them.
ž Batch framing: Frame your pictures with custom photo frames.
ž Making AVI: Make AVI movie with or without watermark.

· Control your output size while you are creating watermarks.
· Automatically size watermark objects with the size of image if you specify watermark size in percent.
· Manage multiple watermark files with the built-in watermark manager: Maximize your creativity, switch 

watermarks in just a single click.
· Three types of objects: Watermark supports a mixture of text, graphic and drawing objects of any complexity.
· Various fill and stroke styles for text and shape objects including gradient fill and bitmap pattern fill.
· Multi-line text objects and various styles.
· Angled text objects
· Automatic objects - Objects that are updated automatically with each image using either file information or EXIF 

data.
ž Auto file info: Stamp your photos with filename and size.
ž Auto date: Stamp your photos with date picture taken and last watermarked in various formats.
ž Auto EXIF table: Show portion or the entire EXIF table on your pictures.
ž Auto age: Place your baby's age on the photos.
ž Camera model and camera settings.
ž Frame: Include an auto adjustable frame for your pictures.
ž Auto number: Mark your picture with its position in the file list.

· Image effects for image object such as emboss, tile, twist etc.
· Emboss and engrave: create true emboss or engrave watermarks.
· Shadow and Shadow3D: Each object has its own drop shadow including non-text objects.
· Smooth rendering of individual object.
· 100 transparency levels: Each object has its own transparency level.
· Insert or paste pictures: JPEG, GIF, PNG, ICO, WMF, EMF, TIFF, BITMAP, JPEG2000 etc.
· Transparent or opaque image object: a single button makes it transparent or opaque.
· Individual object alignment: Each object can have an auto position attribute, which is one of the 9 predefined 

positions. 
You can also set the position to `none', which means that you can manually move the object to a desired position.
· Explorer-style folder tree and file list: Photo files are listed automatically when you select a folder. You can 

optionally open a number of files for watermarking if you do not want to list all photos in a folder.Searching 
photos by date picture taken, size in mega pixels, and any other EXIF data.

· WYSIWYG: What you see is what you get interface.
· Keep your EXIF data: EXIF data are automatically saved in the watermarked files provided they are in JPEG 

format.    
· Various graphic formats: JPEG, GIF, PNG, TIFF, BITMAP and JPEG2000.
· Supports animated GIF and multi-page TIFF files.
· Collage several pictures on a page.
· FTP your pictures from or to your server.
· Detailed hints will be seen when you move your mouse over a command or combo box.
· Tips.
· End user editable language interface.
· Command line argument support: you can automate watermarking by providing proper command line arguments
· Multiple themes.



System requirements
Microsoft Windows 95/96/NT/2K/XP/2003.



License agreement
This software is provided AS-IS, without warranty of any kind, either expressed or implied. In no event shall the 
author be held liable for any damages arising from the use of this software. You should always work on a copy of 
your original photo files. Never watermark your original photos directly. This is irreversible. If this is done by 
mistake, do NOT ask for help since NOBODY can help you with this.



Demo version and purchase
The demo version of this program includes a predefined watermark, which cannot be removed from the center of 
your image unless you purchase this program. However, there is no time limit on the use of our demo software, so 
you can use it for as long as you wish.

PhotoWatermark professional licensed version includes one year unlimited free-upgrades. The program you have 
purchased will of course, last forever. PayPal members can purchase through their PayPal accounts.
We accept most major credit cards.

Please follow this link to purchase PhotoWatermark Professional http://member.photowatermark.com/signup.php.



Credits
Thanks to all who reported bugs and/or gave suggestions. This has helped us to make PhotoWatermark 
Professional to be the world's best photo watermarking tool.

Special thanks to the following people who wrote wonderful free software that is useful to this program:

Jordan Russell
Alex A. Denisov

Mike Lischke
Jim Kueneman

Roy Magne Klever
Momot Alexander

 BitSoft Development, L.L.C.
Chen Yu

Jan Verhoeven
Robert Lee
Zafir Anjum

Thanks to Sharon Colaco-D'Souza for having edited our literature. 



Contacts
PWPro's web site: http://www.photowatermark.com
Support: support@photowatermark.com
Member logon: http://member.photowatermark.com/member.php

All questions will be answered sequentially and in a timely manner. In rare circumstances, answers may be 
delayed. The quality and response time of our customer service have been rated highly by our customers. 
See the testimonials section.



Testimonies
Here's what some of our users have to say about our product and service, as published on Download.com:

Eric 03-May-2004 06:35:55 PM 
       "Great Product. Easy to Use"
The software is easy to use with great features. The tech support is simply outstanding. I emailed them once and 
got the response within hours. They promptly gave me step-by-step instruction to solve my problem. This is a 
must-have software for graphic enthusiast.    

--------------------------------------------------------------------------------
    Ed Ellks 14-Apr-2004 07:25:55 AM 
        "If you want to watermark and convert pictures, this is THE tool."
I've had the pleasure of using this tool for a couple of years. It just keeps getting better and better. Incredible 
amount of flexibility. The best part of the deal is the author. He has always been very responsive and helpful. He 
usually incorporates good suggestions within a day or two. Free updates are a great bonus, too! I have and will 
continue to highly recommend this product.    

--------------------------------------------------------------------------------
    davegisward 05-Apr-2004 05:05:55 AM 
        "Resize and watermark in batch"
Massively powerful product with excellent fine-tuning features to watermark and process EXIF tags. Fantasticly 
responsive tech support. A must have tool for photo inventory.    

--------------------------------------------------------------------------------
    Tom Quinn 30-Mar-2004 04:55:55 PM 
        "Gets the job done fast."
This software 1. Has much capability, 2. Very fast 3. Saves much time, 4. Many features, 5. Support is excellent 
and quick 6. Author listens to suggestions 7. And protects pictures from copying.    

--------------------------------------------------------------------------------
    Jason Cole 29-Mar-2004 12:15:57 AM 
        "Awesome Product & Excellent Technical Support"
This is an awesome product & the author Felix gives great Technical Support and is very responsive to suggestions.
As a photographer it has saved me hours and hours and hours of work watermarking photos. Highly recommended.

--------------------------------------------------------------------------------
    Nicolec 23-Mar-2004 01:55:57 PM 
        "Watermarked 100 images in seconds!"
This is a must for anyone who wants to watermark their images - photographers for sure! The demo software 
watermarks YOUR images with THEIR logo - only bad part - they really want you to spend the 40 bucks.    



known issue
Sep 18, 2004 V 5.5.2.0

None



FAQ and trouble shooting
1. How does PhotoWatermark Professional offer complete digital photo protection?
2. Can anybody remove my watermark with PhotoWatermark Professional?
3. Can I create invisible watermark with PhotoWatermark Professional?
4. Can I get free upgrade service?
5. Can I translate PhotoWatermark Professional for you?
6. Does PhotoWatermark Professional support command line options?
7. Will PhotoWatermark Professional create damage?
8. How can I set a custom target image size?
9. My PWPro program doesn't work properly, why?
10. How do I rename files using the template?
11. How to format date and time?
12. How to format image file info object?
13. How to format age object?
14. How do I create emboss-like watermark?
15. Why my watermarks disappear on certain pictures?
16. How do I enter copyright or registered mark?

1. How does PhotoWatermark Professional offer complete digital photo protection?
 
Since PWPro integrates your watermark into your photos, no one can remove your watermark from your 
images without damaging the integrity of them. Only the author has full control over his/her watermark since 
the author works with the original images. This idea is very similar to the Adobe PDF document except that 
PDF allows the user to make minor changes if allowed by the author. Please ALWAYS keep a copy of your 
original files since NO software program INCLUDING PhotoWatermark Professional will be able to 
remove the watermark from your pictures. If you have deleted your original files, please do not 
hold us responsible, because we cannot recover your pictures.

2. Can anybody remove my watermark with PhotoWatermark Professional?

As discussed above, NO one can remove your watermark without damaging the integrity of your images.

 
3. Can I create an invisible watermark with PhotoWatermark Professional?
 

Creating invisible watermarks is not the purpose of PWPro since it violates our full-protection principle, the 
very reason for which this software was developed.

 
4. Can I get free upgrade service?

 
When you purchase PhotoWatermark Professional, you automatically get unlimited free upgrades for a year 
from your date of purchase. After a year, you can renew it at a discounted price.

 
5. Can I translate PhotoWatermark Professional for you?

 
You are welcome to do so. If you translate PWPro into a language we do not have yet, we will send you a 
complimentary version of PWPro. You will get free upgrades, the same as someone who has purchased from 
us. 

While we understand that what you have contributed could be more valuable than the value of our software, 
our offer of our software is purely a voluntary action. In addition, we will acknowledge your role by giving you 
a credit next to the name of the translated language. Please excuse our inability to compensate you 
monetarily for your efforts.

 
6. Does PhotoWatermark Professional support command line options?

 
Yes, it does. Please refer to the topic on command line use.

7. Will PhotoWatermark Professional create damage?
 

PWPro has been made to function so as not to overwrite your original files. This is a safety feature in case you 
are not happy with your watermark or you want to change your watermark. However, if you choose a folder 
that contains files of the same names, PWPro could overwrite them and permanently damage these files. We 



are NOT responsible for this.

8. How can I set a custom target image size?

In the size edit box, type in your size in WidthxHeight format (e.g. 123x101) and press ENTER.

9. My PWPro program doesn't work properly, why?

For any reason that PWPro does not work properly, please try to delete the watermark.ini file and try to re-run
it. If this is not a solution, please contact support@photowatermark.com.

10. How do I rename files using the template?

The rename template offers a very flexible way to name your files. For example
· If you want to number your files in format of 00x, specify a template of ###
· If you want to number your files with a prefix "Vic" and 0x, specify "Vic"##. You must enclose "c" in 

double quotes since c will be replaced by date and time if not.
· Lets see you have 2000 files taken in a year and you want to number them with the year and number, 

you can specify yyyy_####. This will be replaced by 2004_0001 to whatever number of pictures you 
have.

· If you want to name your files using date and time, you could specify yymmdd_hhnnss, which will be 
something like 040125_123248.

· The formats are virtually unlimited. You should safely play with it.

11. How to format date and time?

Date Time format strings are composed from specifiers that represent values to be inserted into the formatted
string. 

In the following table, specifiers are given in lower case. Case is ignored in formats, except for the "am/pm" 
and "a/p" specifiers.

Specifier Displays
c Displays the date using the format given by the ShortDateFormat global variable, followed 

by the time using the format given by the LongTimeFormat global variable. The time is not 
displayed if the date-time value indicates midnight precisely.

d Displays the day as a number without a leading zero (1-31).
dd Displays the day as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by the 

ShortDayNames global variable.
dddd Displays the day as a full name (Sunday-Saturday) using the strings given by the 

LongDayNames global variable.
ddddd Displays the date using the format given by the ShortDateFormat global variable.
dddddd Displays the date using the format given by the LongDateFormat global variable.
ddddddd Displays the No. of day of the year.
e (Windows only) Displays the year in the current period/era as a number without a leading 

zero (Japanese, Korean and Taiwanese locales only).
ee (Windows only) Displays the year in the current period/era as a number with a leading zero

(Japanese, Korean and Taiwanese locales only).
g (Windows only) Displays the period/era as an abbreviation (Japanese and Taiwanese 

locales only).
gg (Windows only) Displays the period/era as a full name. (Japanese and Taiwanese locales 

only).
m Displays the month as a number without a leading zero (1-12). If the m specifier 

immediately follows an h or hh specifier, the minute rather than the month is displayed.
mm Displays the month as a number with a leading zero (01-12). If the mm specifier 

immediately follows an h or hh specifier, the minute rather than the month is displayed.
mmm Displays the month as an abbreviation (Jan-Dec) using the strings given by the 

ShortMonthNames global variable.
mmmm Displays the month as a full name (January-December) using the strings given by the 

LongMonthNames global variable.
yy Displays the year as a two-digit number (00-99).
yyyy Displays the year as a four-digit number (0000-9999).
h Displays the hour without a leading zero (0-23).
hh Displays the hour with a leading zero (00-23).
n Displays the minute without a leading zero (0-59).



nn Displays the minute with a leading zero (00-59).
s Displays the second without a leading zero (0-59).
ss Displays the second with a leading zero (00-59).
z Displays the millisecond without a leading zero (0-999).
zzz Displays the millisecond with a leading zero (000-999).
t Displays the time using the format given by the ShortTimeFormat global variable.
tt Displays the time using the format given by the LongTimeFormat global variable.
am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any hour 

before noon, and 'pm' for any hour after noon. The am/pm specifier can use lower, upper, 
or mixed case, and the result is displayed accordingly.

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any hour 
before noon, and 'p' for any hour after noon. The a/p specifier can use lower, upper, or 
mixed case, and the result is displayed accordingly.

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays the contents of the 
TimeAMString global variable for any hour before noon, and the contents of the 
TimePMString global variable for any hour after noon.

/ Displays the date separator character given by the DateSeparator global variable.
: Displays the time separator character given by the TimeSeparator global variable.
'xx'/"xx" Characters enclosed in single or double quotes are displayed as-is, and do not affect 

formatting.

12. How to format image file info object?

Image file info format strings are composed from specifiers that represent values to be inserted into the 
formatted string. 

In the following table, specifiers are given in lower case. Case is ignored in formats.

Specifier Displays
f Displays file name without extension, e.g. imagefile
ff Displays file name with extension, e.g. imagefile.jpg
fff Displays file folder, e.g. c:\my pictures
ffff Displays full path to the file, e.g. c:\my pictures\imagefile.jpg.
s Displays original file size in KB, e.g. 121KB.
ss Displays original file size in bytes, e.g. 121,088.
w Displays original image width in pixels, e.g. 1024.
ww Displays target image width in pixels, e.g. 640.
h Displays original image height in pixels, e.g. 768.
hh Displays target image height in pixels, e.g. 480.
c Displays image color depth in bit, e.g. 24 bit.

13. How to format age object?

Age format strings are composed from specifiers that represent values to be inserted into the formatted string.

In the following table, specifiers are given in lower case. Case is ignored in formats.

Specifier Displays
y Displays age in years. If less than a year, this value is 0.
m Displays the No. of months in addition to the year. If less than a month, this value is 0.
mm Displays the total number of months, e.g. 1 year 3 months will be displayed as 15.
d Displays the No. of days in addition to the year and month. If less than a day, this value is 0.
dd Displays the total No. of days, e.g., 1 year, 5 months and 2 days will be displayed as 519.

14. How do I create emboss-like watermark?

Just click Main menu -> Format -> Emboss or Engrave to create true emboss or engrave watermark objects. 

15. Why my watermarks disappear on certain pictures?

The usual reason is that you are using absolute positions for your watermark objects, in which case if you 
have pictures of different sizes, your watermark objects are actually outside these pictures.
Solution: 

1. Use relative positions for your watermark objects. This can be done with the auto position tool in 
the Object editor.

2. Specify image size so that your watermarked pictures will all have the same dimensions.



16. How do I enter copyright or registered mark?

In order to insert copyright and registered marks, you should be running the English version of Windows, i.e. 
your system default language should be English. If your system default language is not English, auto 
formatting (c) or (r) is unpredictable. You must turn on <Options - Auto format (c) and (r) marks>. When this
option is on and as you type, PWPro will turn (c) to copyright mark and (r) to registered mark. If you do not 
want this auto format, you can turn it off. In this way, you can have a mixture of (c) and copyright marks.



Tutorial
This tutorial presents a step-by-step guide to help you create and apply a very simple watermark to your photo 
files. PWPro is more powerful than you would think. Please explore its full features by going through each 
command in the program or help manual.

1. After installation, you have a program group and short cut to PWPro. Please run PWPro by clicking on the 
shortcut to that file. If you do not know how to do this, please ask support@photowatermark.com.

2. The first time you run PWPro, it automatically navigates into your "My pictures" folder. If you want to process 
your photo files stored in other folders, please navigate to the appropriate folder using the Windows Explorer 
style folder tree. If you do not know how to do this, please ask support@photowatermark.com.

3. When you have photos listed in the file list window (listed as thumbnails by default), you can start creating 
your first watermark object. Go to <Object> menu and click <Text>. This will create a default text object in 
the center of your image.

4. While the text object is selected (if not, you can select by clicking it with your left mouse button), click the 
<Object editor> window and change the default text to your own. If you want to type in copyright or 
registered mark, your system must be English and you have to turn on the option <Options - Auto format (c) 
and (r) marks> before you type (c) or (r). You will have unpredictable results if your system's default 
language is not English.

5. If during batch processing, you are satisfied with the position of an object on one of your images, it does not 
mean that the object will be in the center of another image of different size. If you want to have a consistent 
look, you can use the auto position feature to let the object to adapt itself to each of the 9 predefined 
positions regardless of the size of your images. Use the intuitive tool palette to set the auto position attribute. 
Each object can have its own auto position attribute.

6. If you want to insert a logo image, go to <Object> menu and click <Image>. You will be asked to choose an 
image file. The best quality transparent logo should be in PNG format. You have to use your own photo-editing
tool (e.g. Adobe PhotoShop or Jasc PaintShop Pro) to create this logo. Position your logo as step 5. If you do 
not want a logo, please ignore this step.

7. Now you are ready to <Batch watermark> your photos. Go to <File - Batch watermark>. You will be asked to 
change the options of photo conversion and renaming. Click OK to continue. If you want to play with those 
options, it is out of the scope of this very basic tutorial. Please play it on your own or ask 
support@photowatermark.com for specific questions. 

8. Next you will be asked to choose a folder using the standard Windows Browse for folder dialog. If you do not 
know how to do this, please ask support@photowatermark.com. You cannot choose the folder that contains 
your source files unless you turn the option <Options - Allow me to overwrite source image files 
(IRREVERSIBLE! You are 100% responsible)> on. You can select any other folder or create a new one. When 
you have a folder selected, click OK.

9. Now it is time for you to sit back and relax and watch PWPro watermark your photos. When this process is 
complete, the destination folder will be opened (unless you turn the corresponding option off). Please use your
favorite photo viewer to view your watermarked pictures.

If you want to explore all the power of PWPro, please go ahead and do it. Should you have any specific questions, 
please contact support@photowatermark.com.



Using the program
No other program is easier than PWPro. For example:

· Conventional programs usually require you to open files you want to work with. With PWPro, you save this step. 
Simply select a folder and all images meeting the filter requirement will automatically be listed in the list view 
box. These are the files you are going to batch process. By checking the Recursive button, PWPro will list all 
photo files in the selected folder and all its subfolders. If you do not work on all images in a folder, you can use 
the conventional File -> Open command.

 
· PWPro has a user interface very similar to Microsoft Office. All commands are available in the main menu system

with the most commonly used commands on the four tool bars and popup menu.
 
· Unlimited undo's and redo's are very convenient.
 
· Real time command enabling and updating system assumes very little confusion.



Command line use
PhotoWatermark Professional supports the following command line switches:
 
· /s - Optional. This switch specifies the source folder. The actual folder string (in double quotes if folder path has 

space) must follow this switch. If this parameter is ignored, PWPro will open the last visited folder.
· /d - Required. This switch specifies the destination folder. The actual folder string (in double quotes if folder path 

has space) must follow this switch. If this is ignored, PWPro will run normally.
· /w - Optional. This switch specifies the default watermark file. You do not need to specify the folder because 

PWPro will assume it is in the default "My Watermarks" folder. The ".wmk" extension is not necessary either. If 
this is an in existing file, PWPro will use the one you used last time. If this parameter is ignored or no watermark
files are available, PWPro will run as normal and create a new watermark file for you to work interactively. 

 
When proper parameters are specified, PWPro will open the source folder, load the watermark file and begin batch 
watermarking automatically. 
When automatic watermarking is triggered, PWPro will overwrite files in the destination folder without
asking for confirmation. So BE CAREFUL.
When automatic processing is finished, PWPro will close itself unless the user cancels it.

Here is an example:
watermark /s "c:\my pictures" /d c:\output /w "Watermark (2)"



File menu
The file menu has the following submenu commands:
· Watermark

· New watermark (Ctrl + N): Create a new watermark file and set it as the default. Whatever you create will be 
saved in this file. If you do not create any watermark objects, this file will be deleted on exit.

· Delete watermark (Ctrl + Del): Delete selected watermark file and set the default watermark file to the next 
one.

· Select watermark: Select a watermark file from the watermark list. This works the same way as you select a 
watermark file from the watermark manager.

· Rename watermark (F2): Rename the current selected watermark file.
· Import: Import a watermark file. It will be added to the current watermark file. So if you want the contents in 

that file only, please create a new watermark file and then import.
· Export: Export the current watermark objects to a file.
· The last menu shows the default watermark folder. By clicking this folder, you change this default folder. 

However, when you reinstall the program, this value will change back to the default.
· Save attributes

· Save as Text : Save attributes as text file.
· Save as CSV: Save attributes as comma delimited data file.
· Append to CSV: Append attributes to an existing comma delimited data file.
· Batch save to CSV: Batch save all image attributes to a comma delimited data file.

· Open (Ctrl+O): Open a number of files to work with. Use Shift or Ctrl key to select multiple files. The selected 
files will be shown in the file list until you change folder or open other files.

· Save current image as: This refers to the image being displayed in the main window. It uses the Default JPEG 
quality value found under Options if saving as JPEG files.

· Print current image: This refers to the image being displayed in the main window. It uses the Default JPEG 
quality value found under Options if saving as JPEG files.

· Refresh (F5): Refresh the folder tree and file list.
· Recursive: If checked, PWPro will list all photo files in the selected folder and all its subfolders.
· File filter: This determines the types of image files to be shown in the list.
· Sort:

· Sorting direction
· Sorting criteria list

· Batch watermark (Ctrl+W): Batch watermark all images in the file list.
· Batch process images (F3): All batches except batch watermarking are available here.
· Make AVI: Make AVI movie with or without watermark.
· Batch rename (F2): Batch rename all files in the file list.
· Batch print (Ctrl+P):    watermark and print out all your images.
· Exit (Alt+X): Exit.



Image menu
The image menu has the following submenu commands:
· Resample filter: Used when selecting target image size other than "Original". 11 filters are available. They are: 

Triangle, Hermite, Bell, BSpline, Lanczos3, Mitchell, Nearest, Linear, FastLinear, Bilinear, Bicubic.
· Image size: This is the target image size. PWPro will resize each photos in the memory (without touching the 

original) using the resample filter if you select the image size other than "Original". Use #x# to specify a custom
size.

· Stretch image: When checked, PWPro will stretch the image to fit the specified size. Otherwise, it will keep each 
image's aspect ratio.

· Large only: When checked, PWPro will only shrink images that are larger than the specified size.
· Keep long side: when checked, PWPro will resize your pictures according to its long side. For example, if you 

resize a photo of 768x1024 to 640x480, you actually get 480x640, otherwise, you get 360x480.
· Enlarge canvas to fit watermark option under "Image menu". If you have watermark object that is larger than 

your image, a white edge can be automatically added to your image in order to accommodate your watermark. 
This does not work with object specified by percent in size.

· Page: List the number of frames in the image file. Only GIF and TIFF can have more than one frame. Therefore, 
most of the time, there will be one page only. Choose a page number to display that frame.

· Enhance
· Orientation: display the orientation commands allowing you rotate or flip your pictures.
· Definition: allows you to sharpen or soften images.
· Color functions: allows you to create negative, grayscale, or sepia images.
· Color balance: allow you to adjust Red, Green, Blue of your pictures.
· Hue and saturation: allow you to adjust hue, saturation and luminosity of your pictures.
· Lighting: allow you to adjust the brightness, contrast and gamma of your pictures. An auto adjust algorithm is

available.



Crop menu
The crop menu has the following submenu commands:
· Left: The left position of the crop window. Use the arrow to change value or type your value in the edit box.
· Top: The top position of the crop window. Use the arrow to change value or type your value in the edit box.
· Width: The width of the crop window. Use the arrow to change value or type your value in the edit box.
· Height: The height of the crop window. Use the arrow to change value or type your value in the edit box.
· Load default: Load your default crop window.
· Set default: Set the current crop window as your default value.
· Clear selection: Clear current crop window.



Collage menu
The collage menu has the following submenu items:
· Canvas size: Choose or type in the canvas size in width x height format (e.g. 123x88) and press enter.
· # per page: Choose the # of pictures per page. You cannot type in the edit box here.
· White margin: Choose or type in a value and press enter.
· Repeat: If turned on, the same picture will be repeated on the page.



FTP menu
FTP menu has the following submenu items:
· Connect: Connect to your server using the user name and password you specify. You have to specify all three 

parameters (sever address, username and password) correctly. The default port # is 21. If your server has a 
different port #, you need to change this too.

· Disconnect: Quit current connection.
· Anonymous connect: You only need to specify a server address and correct port # for this type of connection. 

Your user name and password will be ignored.
· Parent dir: Go up one level of the directory on your server. You cannot go beyond the root directory.
· New folder: Create a new folder in the current directory on your server.
· Rename: Rename the currently selected directory or file on your server.
· Delete: Delete the selected directories or files on your server.
· Upload: Upload the selected local files or folders to your server. Please use the folder tree to navigate local 

folders and the explorer list view to select the local files or folders. The image file list window is disabled during 
FTP.

· Download: Download the selected files and directories from your server to the currently selected local folder.
· Refresh: Refresh the server list.
· Stop: Stop the current transfer.
· Show all files on server: If not checked, only image files are displayed.
· Passive: FTP using passive mode.
· ASCII mode: When checked, files are transferred using ASCII mode, otherwise, binary mode is used.



Frames
Frames menu has the following submenu items:
· Refresh: reload frame files. Frame files are located in "Frames" folder under the program folder and "My 

watermarks" folder. If you make custom frames, you must store them in either of these locations. Frames files 
are PNG files with alpha transparency. Only the parts that matches the transparency in your photos are shown.

· None: use none frame. Click to clear photo frame.
· Use: use the selected frame.
· Random frame: randomly choose frames from the list.
· More frames online: obtain more frames from our website. Only registered users have this privilege.



Edit menu
The edit menu has the following submenu commands:
· Undo (Ctrl+Z): Undo last change. PWPro has unlimited undo's. If you insert large pictures in the watermark, this

process is slow.
· Redo (Ctrl+Y): Redo last undo.
· Copy (Ctrl+C): Copy the selected objects to clipboard.
· Cut (Ctrl+X): Cut the selected objects to clipboard.
· Paste (Ctrl+V): Paste as image from clipboard. PWPro supports the following clipboard image format:

ž Bitmap.
ž Windows Meta file.
ž PWPro internal vectorial object format.
ž Delete (Del): Delete selected objects.
ž Reset image: Reset graphic object to its original size and aspect ratio.

· Make image current size: When you insert an image object, you could resize that image. However, PWPro will 
keep the original image and only resize it on the screen. This may increase your file size. You could use this 
command to make that image to the current size on the screen.

· Crop: Use the object editor to select a portion of the image and click this command to crop it. This is a 
permanent change.

· Clear selection: Clear the selected region in the image editor.
· Set transparent color: When checked, you can click a pixel in the image editor to set that pixel as the 

transparent pixel.
· Set image transparent: Turn on or off image object's transparency.
· Image effect: these commands are applicable to the inserted image object, not the working one.

ž Create image from selected objects: create a new image object from the selected objects, which are 
intact.

ž Add noise: add noise to an image object.
ž Antialias: antialias an image object.
ž Blur: blur an image object.
ž Circle: only keeps the part inside the circle, and the rest turns black. Then you can reset the transparency 

so you get a circular object.
ž Emboss: emboss an image object. See FAQ for example.
ž Mosaic: mosaic an image object.
ž Tile: tile an image object.
ž Trace: trace an image object.
ž Twist: twist an image object.
ž Gray scale: turn an image into grayscale.
ž Rotate: rotate inserted image at any angle.
ž Flip horizontally
ž Flip vertically

· Select object: It has submenus listing all objects. By clicking that object, you select that object.
· Select all: Select all objects.
· Select invert: Invert the selection.
· Select none: Clear selection.
· Auto position: It has the following submenus:

ž No auto position: The object can be freely positioned.
ž Nine predefined positions: When an object has auto position attribute, it cannot be positioned manually.
ž Group: Group and ungroup objects.

· Order:
ž Send to bottom: Send selected objects to the bottom layer.
ž Bring to top: Bring selected objects to the front layer.

· Size:
ž Grow: Make selected objects bigger.
ž Shrink: Make selected objects smaller.

· Move:
ž Move in bound: If any objects are outside the image bound, move them in.
ž Move left
ž Move right
ž Move up
ž Move down

· Align or distribute
ž Align left: Align selected objects to the left edge of the first (top) object.
ž Align center: Align selected objects to the center of the first (top) object.
ž Align right: Align selected objects to the right edge of the first (top) object.
ž Align top: Align selected objects to the top edge of the first (left) object.



ž Align middle: Align selected objects to the middle of the first (left) object.
ž Align bottom: Align selected objects to the bottom edge of the first (left) object.
ž Distribute horizontally: Distribute even space between selected objects horizontally.
ž Distribute vertically: Distribute even space between selected objects vertically.



Format menu
The format menu has the following submenu commands:
· Transparency: Sets the selected object's transparency. Values are from 0 to 100 % where 100% means totally 

transparent and 0 means opaque.
· Emboss: Emboss selected objects.
· Engrave: Engrave selected objects.
· Shadow: 

· Enable shadow
· Shadow3D
· Shadow radius
· Shadow X offset
· Shadow Y offset

· Smooth: smooth render text or shape object.
· Text auto size: when a text box has this attribute, you cannot size it manually.
· Fill: Sets the fill style of shape and text objects.

· The first group of palette contains object fill styles. 30 styles are available. 15 are colors including 10 gradient 
colors. 14 are bitmap patterns, and one, custom picture.

· The second group defines the begin color for gradient fill.
· The third group defines the end color for gradient fill.

· Stroke: Sets the stroke color and width.
· Font

· Font name: Changes name of the font of the selected text objects.
· Font size: Changes size of the font of the selected text objects.
· Font angle: Changes angle of the font of the selected single line text objects.
· Font color: Changes color of the font of the selected text objects. This is a shortcut of a combination of stroke 

and fill. Selecting a font color will change the stroke color and fill begin color to the same, the stroke width to 
1 and the fill style to solid.

· Bold
· Italic
· Underline
· Strikeout
· Align left
· Align center
· Align Right



Object menu
The object menu has the following submenu commands:
· Select: If checked, clicking on objects will select that object. This is checked automatically after creating a new 

object.
· Text: When checked, click and drag in the image area to create a new default text box. Use the object editor to 

change the text.
· Image: When checked, click and drag in the image area to create a new graphic object. You will be prompted to 

open a graphic file.
· Line: When checked, click and drag in the image area to create a line object.
· Box: When checked, click and drag in the image area to create a box object.
· Ellipse: When checked, click and drag in the image area to create an ellipse object.
· Polygon: When checked, click and drag in the image area to create a polygon object. Double click to close the 

polygon.
· Image file info: Click to insert an image file info object in the center of the image area. Use the object editor 

change the format. For a full list of format strings, please read FAQ.
· Age: Click to insert an age auto field in the center of the image area. Using the object editor change the format. 

For a full list of format strings, please read FAQ.
· EXIF table: Click to insert an EXIF table auto field in the center of the image area. Using EXIF table editor turn 

on and off entries.
· Date: Click to insert a date and time auto field in the center of the image area. Using the object editor change 

the format. For a full list of format strings, please read FAQ.
· Camera setting: Click to insert a camera setting object in the center of the image area. This includes F-number, 

Exposure time, ISO speed rating and flash status, e.g. F4.5 1/500 ISO100 Flash off.
· Camera model: Click to insert a camera model object in the center of the image area. This includes the model 

and make of the camera, e.g. C3000Z (Olympus Optical CO, LTD.).
· Last watermarked: Click to insert a date and time object which shows when the image is last watermarked. You 

apply the same format string as in EXIF date time object. For a full list of format strings, please read FAQ
· Auto number: Mark your picture with its number in the file list.
· Frame: Click to insert a picture frame. Frame is a box object that automatically adjusts itself to fit the entire 

image area. You can change the line width, color and background color of the frame. Each frame can also have 
its own transparency level and soft shadow. By layering several frames of different line width and color on top of 
each other, you can create special framing effect. 



View menu
The view menu has the following submenu commands:
· Restore all: display all dockable windows as their defaults.
· Old interface: Hide all right side dockable windows and make the object editor float.
· Standard tool: Turn on or off standard tool bar.
· Formatting tool: Turn on or off formatting tool bar.
· Image: Turn on or off image tool bar.
· Tip tool: Show or hide tip tool bar.
· Attributes: Turn on or off attributes panel. Attributes window works properly only in ANSI character set.
· Very basic: show or hide very basic tool bar.
· Show wizard: show or hide wizard.
· Watermarks: Turn on or off watermark manager panel.
· Zoom: Choose among several predefined numbers and fit or enter a custom number. If set to fit, large images 

will be shrunk but smaller images not stretched.
· Themes: Choose one of the available themes from its submenu.



Options menu
The options menu has the following submenu commands:
· Multipage image support: Default is on which means PWPro supports multipage TIFF and animated GIF files.
· Auto format (c) and (r) marks (English only). This option only works with ANSI system.
· Convert and rename options: This will bring up the convert and rename options window. Most settings are 

globally used.
· Allow me to overwrite source image files (IRREVERSIBLE! You are 100% responsible). If this is unchecked 

(default), you cannot overwrite your source image files. This action is dangerous. Overwriting your source image 
files is an irreversible process. Nobody on earth could reverse it if you make a mistake.

· Use file date: When checked, auto date objects will use file date if EXIF date not available.
· Hide EXIF titles: When checked, EXIF table will hide EXIF titles, i.e. only display EXIF values.
· Hide Empty entries: When checked, EXIF table will not show entries with empty values even that entry is 

selected.
· Hide error objects on watermarked photos. If checked, the error watermark objects will not be shown on your 

final products. This prevents you from removing these objects when you have photos that do not contain EXIF or
are taken before your specified birthday.

· Open destination folder when processing is complete: If checked, PWPro will open the destination folder when 
batch watermarking or convert-resizing is complete.

· Save and use saved crop windows. When checked, the crop windows will be saved in the folder where your 
photos are. They will be automatically loaded in the future. However, when the size of any of your photos is 
changed, the crop window will be discarded.

· Default auto position margin: The distance from the margin used to auto position objects. Each object also has 
its own margin properties. This is the default value when you first auto position an object.

· Turn off error message.
· Use zoom filter.
· Language:

· Edit current language file: If the language is selected, click this to edit the language file.
· Translate into xxx: If language is set to Auto language detect and the language file that match your system's 

default language does not exist, click this menu will generate a language file for you to translate.
· Auto language detect: If checked, PWPro will select the appropriate language for your system's default 

language if the proper language file is available; otherwise, it uses the default English language.
· The rest of the submenus depend on the available language files.



Help menu
The help menu has the following submenu commands:
· What is new: Access what's new in the help file.
· Tutorial: Access the step-by-step tutorial.
· FAQ: Access the FAQ.
· Contents (F1): Open this help file.
· Support: To visit our web site for technical support.
· Purchase: To visit our web site for purchasing PWPro. This menu is not available in the licensed version.
· Tip tool: Show or hide tip tool bar.
· About: About PWPro.



Convert and rename options
The top convert page has 8 tabs. Each tab represents an image format except <As is>, which means no 
conversion. If you want to convert your images to a specific format, set that tab as active and click OK. You still 
have the chance to do this when you actually perform the batch processing.

For beginners, it is advised to accept the default settings for each image format. Advanced users can play with 
various image settings to obtain desired results.

The rename page allows you to specify a template. For a detailed description of the template format strings, please
refer to the FAQ. The rest is self-explanatory. If you have any specific questions, please contact 
support@photowatermark.com.




